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To download and install Irises, see the Download and Installation Instructions at the end of this 
document. 

 

The following steps prepare for image input: 

To start an analysis, create a new folder.  You will create various input files for your analysis as 
instructed below.  Put all of these files in this folder.  Irises will ask for this folder and will save the 
results into it. 

 

The Irises Interface: 

The Irises Interface is designed with a top-to-bottom workflow in mind. Steps 1-4 represent the main 
input-to-output flow of the program. Steps 5-7 represent modifications and analyses of the data 
generated by steps 1-4. Step 5 allows the user to edit output files. Step 6 updates image intensity data 
stored in the zip file given edits made in step 5. 

 

Running the analysis, starting with your image file 

1) Open Z-stack file in ImageJ.  Save as .tif file (File>Save as>Tiff…). Save the file to the folder 
created above. Other output files will be added to that folder below. 
 
STEPS 2-4 FOR MAC USERS ONLY. PC USERS DOUBLE CLICK ON Irises.exe AND SKIP 
TO STEP 5 
 

2) Find the path to the file Irises.app on your computer.   
Example: To locate the path, select the file from the finder window and choose “File>Get 
Info”.  Copy the information under “Where” in the “Get Info” window after the first 
apostrophe up to the backslash before the file name. 

3) Open a Terminal window by opening the Terminal application found under 
Applications>Utilities>Terminal.app. In the window that opens, type “cd[space]” and then paste 
or type the path to the folder that contains “Irises.app”.  Press enter.  

Example command: “cd /Users/username/Desktop/Irises/”  (note that in some cases, the 
command line supplies home directory information by default, in which case the 
information after “username/” will suffice) 

4) Type “./run_Irises.sh”, press enter and wait for program to open (may take a minute; ignore 
Time Machine bypass error messages if they appear). ).   

Note: Even while using the Irises Interface, the open Terminal window will give 
information on the progress of each step and will alert user if there are errors. 

5) This will open a graphical user interface (GUI).   
Note: if you wish to scale the GUI window size it must be done proportionally to preserve 
the image appearance, but this does not affect the underlying calculation. 

6) Irises Interface Step 1: Browse to find desired image (.tif file created in step (1) above), select it 
and wait for it to load. You will see a z-projection of the image. 



7) Irises Interface Optional Step 1b: If you wish to edit any parameters from the parameter file for 
this image only (i.e. not a change you want to save), you can do this using the button labeled 
“Optional: Modify Segmentation Parameters.” 

8) Irises Interface Step 2: Define the Region Of Interest (ROI). (If necessary, return to the .tif file to 
find landmarks that may be less obvious in this rendering of the z-projection). Click once on 
image and move cursor slightly to activate cursor shape change (arrow to +). Click (but do not 
hold) once again to begin outlining ROI. A blue dot should appear marking the start point, and a 
line should appear from the start point as you define the ROI. Click to change the direction of 
the line and define the ROI polygon; each click will define a corner of a polygon.  To finish the 
polygon, click on first point again to close – the cursor appears as a circle when you are over 
the starting point. Once a ROI is drawn, the next click will delete that ROI and you can start 
another one to analyze. Only one ROI can be analyzed at a time. 

Note: errors messages in the Terminal window referring to “finalpoints” may indicate 
aberrant ROI definition. In this case, quit Irises and return to the Terminal window 
“./run_Irises.sh” command. 

9) Irises Interface Step 3: Use the browse button next to “Output directory:” to select the 
destination of your output. 

10)  Irises Interface Optional Step 3b: To individually distinguish files for each ROI, you can add a 
suffix at this step that will be added to all output files generated for that ROI (e.g., to match the 
region of the germ line you selected, i.e. proliferative, pachytene, etc.). This suffix will be added 
to the name of the output file. This makes it easier to keep track of output files later. Otherwise 
successive ROIs for the same image output to the same location may overwrite previous 
results. 

11)  Irises Interface Step 4: Click “Run Nuclear Identification”. You can follow progress in the 
Terminal window. When it has completed the analysis it will return “All nuclei completed.”  

12) The segmentation results will be written to two “.zip” and two “.xml” files in a subfolder in your 
output directory. The file names will be related to your image file name and one of the two of 
each will include the suffix “_edited” in the filename. All later steps in both Irises and AceTree 
should be performed on the “edited” version of these files while the other remains clean for re-
editing if necessary. The .zip files represent the numerical data generated by the program and 
the .xml contains links to the zip file and the image associated with that numerical data.  
 
ALL SUBSEQUENT STEPS ALLOW EDITING AND ANALYSIS OF .zip AND .xml OUTPUT 
FILES GENERATED ABOVE 
The user can open previously generated output files or work on newly generated files using the 
steps below. 
 

13) Irises Interface Step 5: Click “Edit Nuclear Identification” to open the AceTree interface to modify 
the nuclei defined by the main program above. Manual editing nuclear identification is 
essential for accurate results and CANNOT be skipped.  Instructions for this modification 
using AceTree are in a separate section below. 
 

----------- Go to Editing nuclear identification with AceTree below---------- 



 

14) After you have performed the necessary edits in AceTree and saved the modified .zip file, quit 
AceTree Launcher and return to the Irises Interface.  

15) Irises Interface Step 6: Click on the “Select xml file” to select the .xml file that you edited in 
AceTree.  Once the file is selected, the fluorescence intensities for each nucleus will be 
calculated automatically for its corresponding .zip file. This updates the intensity values in the 
zip file to match the edits to nuclear positions already saved in the .zip file. If not done, edited 
nuclei will lack correct intensity values. 

16) Irises Interface Step 7a: Click “View Results” to get a quick look at a data set. Another GUI will 
open.  Use the Browse button to select the .zip file you saved in step (5) of the AceTree section 
below (intensity values will only be correct after you have done Step 6 above).  In addition to 
displaying the data, the information will be automatically saved as an Excel file in the same 
folder. The Excel file is a comma separated value file; select the comma delimiter option under 
[Data>Text to Columns…] to display the X, Y, Z coordinates, cell diameter and fluorescence 
intensity for each nucleus. 

17) Irises Interface Step 7b: To graph data and/or to use one ROI to normalize another ROI, click 
“Calculate and display normalized data” at the bottom of the results window.  This will open 
another GUI where you can browse to select a .zip file to analyze. The user can graph raw 
fluorescence data (unnormalized) by clicking the “None” button. Browse to open a .zip file for 
the ROI to be analyzed. This is the only input file needed to graph unnormalized, raw 
fluorescence data. Or you can normalize one ROI to another ROI of known haploid equivalence 
(N-value). Choose either the 2N or 4N button depending on whether your ROI of known N-value 
is 2N or 4N. If the “2N” or “4N” buttons were clicked, browse to open a second .zip file for the 
ROI to use for normalization. If you would like the displayed histogram or an excel file of the 
normalized values to be saved, click on the appropriate “select to save” buttons and browse to 
an output directory to which it will be saved. Click “Calculate N values and plot in histogram” and 
your results will be displayed. As above (step 16), the Excel file is a comma separated value file. 

 

Editing nuclear identification with AceTree  

1) After clicking “Edit Nuclear Identification” (step 5 within the Irises interface), an AceTree window 
opens.  Alternatively, you can double click on “AceTree.jar” file from the Finder window. 

2) To open the .xml file related to your image, go to “File” in the AceTree window and click “Open 
config file” and choose the “.xml” file related to the series you are interested in (open the 
“_edited” version; it will be located in a subdirectory within the output directory you defined in 
step 3 on the Irises Interface, bearing the same folder name as the output directory). 
When you open the file, the image will come up as a z-stack with circled nuclei that Irises has 
identified. These circles define the nuclei of interest. The AceTree interface lists each 
nucleus/circle defined within the entire stack. Clicking on the circle in the image will show/hide 
its identity. To select the z-center of the circle, control-click on the image or select in the list. 
Double-clicking on the list entry for a nucleus brings up the z-layer containing the center of the 
nucleus. Selected circles are white; all others are purple.  



Example: “Nuc001_4_830_466” on the list defines nucleus in Z plane 4 and XY 
coordinates 830 and 466 

3) Navigate through the image slices by clicking on the image window and using the “Up/Down” 
arrow keys on the keyboard.  Start from the top of the stack (see image header – “p01” is the 
first plane) and navigate down.  

Note: Pressing the left/right arrow keys may produce a black image but you can navigate 
back to your image by return-navigating left/right. 
Notes on defining nuclei: The circles in each plane are a slice through the sphere 
defined by Irises. Every sphere defined by the circles should encompass the entire 
fluorescence of one nucleus without including extraneous fluorescence from neighboring 
nuclei.  
Each acceptable nucleus will therefore be defined as a small circle in one plane 
with increasing diameter in neighboring plane(s), and symmetrically smaller 
diameter until it is no longer associated with the nucleus.  

4) To adjust, delete or add circles, go to the AceTree interface “Edit>edit tools”.  This will bring up 
two new windows, labeled “Adjust or Delete Cells” (used to adjust existing circles, delete circles, 
or delete all circles in an entire Z-plane) and “Edit Track” (used to add nuclei/circles). 

Note: Only those layers that contain whole nuclei should be used in the 
analysis; ~15-20 layers are typically included in the analysis of C. elegans germ 
cells where the distance between each layer is .5 µm. 

a. To add a circle, click on the “Use ROOT Cell” button in the “Edit Track” panel.  Check 
the box marked “Is early set correctly?” and click “Add Intermediate Cell”. The next click 
on the image window will add a circle. Then click “Stop Adding.” Repeat for further 
additions. 

b. To adjust a circle, click on its designation in the AceTree list and you can change its size 
or position using the “BIG”, “SMALL”, “LEFT”, “RIGHT”, “UP”, “DOWN”, “INCZ” and 
“DECZ” buttons.  The last two change the plane that the nucleus is centered on; this is 
particularly useful to separate nuclei that otherwise overlap in the Z plane. If these 
adjustments do not resolve the problem, delete one or both circles. Size and position 
can also be changed by typing in the appropriate numbers in the spaces next to X, Y, Z, 
and D.  

c. To delete a circle, select the circle on the list and click “Kill cell.” Click “Apply changes” to 
delete. Alternatively you can delete nuclei with the Delete Key on the keyboard. 

d. To delete cells above or below a given Z-plane click “Kill Group” and indicate in the “Kill 
Group” window  (NOT on the image) from which layer number above or below which all 
circles should be deleted.  The + and – buttons change the plane number in the “Kill 
Group” window. The “Above” and “Below” buttons may not be mutually exclusive so be 
sure that only one of them is checked.  The “Estimate” button will provide the number of 
nuclei that will be deleted from the analysis. “Kill Cells” will perform the deletion.  

Note: If the image or AceTree interface is not responsive after this manipulation, 
close the “Kill group” window. 

5) To save the changes made, go to AceTree interface “File” then “Save nuclei as zip”.  Click on 
the “_edited.zip” to overwrite the file originally designated with this name. This saving can be 
done at any time and it is recommended that you save often because there is no undo button.  If 



you made a mistake, you can reverse it by closing and reopening AceTree, but you will lose all 
unsaved changes. 

6) Return to step (15) above (step 6 on the Irises Interface) to finalize these changes. 

 

To return to previous files and analysis 

The Irises interface can be used to view, edit and analyze results from any existing .zip or .xml file 
previously generated by Irises and AceTree by using the buttons in steps 5-7 of the Irises Interface. 

 

Background Correction 

Though not necessary in our images and analysis, in some circumstances background correction may 
be useful to remove intensity originating from out of focus light or from background staining.  This is 
particularly the case when signal is weak relative to background intensity. If a uniform background 
correction is needed, during editing a dummy cell can be added in an empty region of the image. Follow 
the instructions above for adding a circle.  Once results are generated the expression value for this ’cell’ 
can be subtracted from all others in Excel. The dummy cell can then be deleted from the file and the 
results saved with an alternative name before plotting histograms or any other downstream analysis. A 
local background correction value specific to each cell is sometimes useful to avoid signal interference 
between tightly packed cells or in the case of spatially uneven background intensity. Local correction 
values per cell (see [4] for details) can be found in the raw nuclei .zip file output.    

 
Image collection for C. elegans germ line studies  
 
Images used in development of this tool were collected as follows:  
L4 stage larvae were ethanol fixed, DAPI stained and mounted on 5% agar pads as previously 
described [1-3]. Sequential images at 0.5µm Z intervals were captured on a Zeiss Z1 Axioimager with 
Apotome using and AxioCamMRm digital camera and Zeiss AxioVision software, and were saved in the 
Zeiss zvi format. We found that images collected from either a 40x and 63x oil immersion objectives 
gave similar results without modification to the parameters used in Irises other than editing the number 
of slices setting in the parameter file to match the number of z-planes in the image stack. 
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Download and Installation 

 

You should download the following  item available via SourceForge 
(http://sourceforge.net/projects/irises/files/): 

compiled_mac.zip or compiled_pc.zip 

Unzip. 

 

One time setup for computer to be able to run analysis: 

Install MATLAB Compiler Runtime: 

For MAC -- 

1) Go to http://www.mathworks.com/products/compiler/mcr/index.html and click the link under row 
R2013b and column Mac to download “MCR_R2013b_maci64_installer”. 

2) Double click “InstallForMacOSX”. 
3) Click “Next” to being installation.  Accept the terms of the license agreement and hit “Next”. 
4) You will be asked where to select an installation folder.  The default should be 

“/Applications/MATLAB/MATLAB_Compiler_Runtime”.  If it is not, choose this folder.  Click 
“Next” and create the folder. Note: that if the compiler runtime is already installed in a 
different location it will be necessary to edit the contents of run_irises.sh to point to this 
alternate location. 

5) Click “Install” and wait for installation to complete.  Click “Next” when told “Your installation may 
require additional configuration steps.”  This is already taken into account.  

For PC -- 

1) Go to http://www.mathworks.com/products/compiler/mcr/index.html and download the R2012b 
Windows version that is appropriate for your machine. 

2) Double click “MCR_R2012b_win32_installer”. 
3) Click “Run”. 
4) After a brief wait, it will bring up a screen asking you to install “MATLAB Compiler Runtime 

7.16”. Click “Next”, accept the license agreement then click “Install”. 
5) When the installation is done, click “finish”. 
6) Typically it is necessary to reboot the PC even if not prompted to.  

 

Initial Setup: 

Each lab will have to set up the program optimized for their own purposes. There is a single text file, 
named “example_parameter_file.txt” which is used to specify the parameters Irises requires to operate, 
including the paths to necessary files, calibration of xy and z microns per pixel, etc. The default file is a 
starting point, but several parameters may need to be optimized for each application. It is 
recommended that the user save a copy of the example_parameter_file.txt before editing. The one 



intended for use with the program should maintain the name “example_parameter_file.txt.” The 
annotation in the parameter file explains what each parameter tells the program and how to edit for 
better results. The most commonly altered parameters can be changed within the Irises Interface for 
that particular run of the program (optional step 1b in the flow chart), but these changes will not be 
made within the saved parameter file. 

The parameters that often need to be edited are listed below.  It is recommended that you do not 
change the other parameters. 

Note: only change parameters to the right of equal signs and only change them when 
you need to. 

1) firsttimestepdiam: specifies the approximate diameter of nuclei in pixels.  This should only need 
to be changed if nuclei are grossly abnormal in size.  

Note: For C. elegans germline nuclei, although the actual size of nuclei in pixels changes 
slightly relative to the magnification, we found that an estimated diameter of 30 works 
well for images captured by either 40x or 63x immersion lenses. The boundary_percent 
parameter (below) compensates. 

2) xyres and zres: tells you the size of each pixel in microns.  XY is within the image plane and Z is 
between them.  If the size of each pixel in microns is not known, open the image file (.zvi or .tiff, 
see below) in ImageJ. The information can be found in Image>Properties or Image>show info 
under “scale factor for X…for Y…for Z”. 

3) slices: number of planes in the image.  
NOTE: the default is for Irises to analyze all planes. This parameter can be set to fewer 
planes than are in the stack within the GUI to exclude unwanted planes for a particular 
analysis.  

4) parameters.intensitythreshold: specifies the intensity threshold to identify nuclei. Lower this 
number if nuclei with weaker fluorescence need to be identified.  

Note: For C. elegans germline nuclei, an intensity threshold of about 6 is optimal under 
the conditions used to collect example images associated with this paper.  

5) parameters.boundary_percent: this specifies the ratio between the brightness outside a nucleus 
and inside a nucleus.  A lower value indicates a larger difference between the two areas. To 
improve accuracy and reduce manual corrections (see below), increase this number if 
background is high or lower this number if background is low.  

Note: For C. elegans germline nuclei, a combination of firsttimestepdiam=30 and 
parameters.boundary_percent=.14 is optimal for performance under the conditions used 
to collect example images associated with this paper. 

As long as all program files, including the parameter file, are kept in the same folder and are not 
renamed, Irises will be able to find and use them. This does not include input and output files which are 
specified using browse buttons within the Irises Interface. If a file is moved or renamed, the parameter 
file will need to be edited to reflect these changes. To avoid this situation, it is recommended that the 
files downloaded as part of the Irises package are not moved or renamed. 

You should also have  

An image stack to analyze. Any format can be used, provided it can be opened in ImageJ and saved as 
a tif stack (see instructions on using Irises). 
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